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IIIInnnnttttrrrroooodddduuuuccccttttiiiioooonnnn

Congratulations! You have chosen a graphic card from Village Tronic. We would like to thank you for
your trust in us and decision to buy one of our products. We are sure that your new MacMagicª will
meet your expectations everyday.

Village Tronic graphic cards have been available since 1992. To begin with they were only available
for Amiga computers. Easy installation, low price and high stability have distinguished our products
from the beginning.  They opened up new regions, previously thought unattainable for this platform.
Until we arrived people had searched in vain for this combination of attributes. Many user groups had
simply been waiting for us.  The first models gained ground rapidly due to the enthusiasm of users
and dealers. The usersÕ joy in the product was evidently so great that the manual was translated,
without our knowledge, into more than 20 languages. Our attention to detail, which was one of our
strengths during the development of our product, but also our determination to eliminate mistakes
and incorporate suggestions, obviously spread to the users of the Amiga platform.

Today we are proud that we can preserve our strengths in the Macintosh market and even here pro-
vide for new impetus. Village Tronic has been decisively instrumental in the development of graphic
cards from luxury goods for high-end desktop publishers to reasonable products for everyone. Until
today it has been the unique and unparalleled modularity which makes Village Tronic cards stand out
and allows them to be individually expandable.

Your new MacMagicª is no different. This 3D hardware accelerator offers maximum performance
and compatibility with your Macintosh system at a very attractive price. Even our least expensive ac-
celerator card is expandable. In this way our MacPablo video out module can greatly increase your
gaming fun. We wish you as much enjoyment and fun using your new MacMagicª (with or without
MacPablo) as we had developing it.

Marc Schmitt
Product Marketing Manager, Village Tronic Marketing GmbH
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IIIInnnnssssttttaaaalllllllliiiinnnngggg    tttthhhheeee    HHHHaaaarrrrddddwwwwaaaarrrreeee

Have courage ... Installing a graphic card is not very difficult and can even be done by
someone new to computers. The times when simply opening a Macintosh
could endanger your warranty are over. Even the cases of modern Apple
computers are so designed that upgrading RAM or installing a graphic
card is very easy. Please refer to the installation instructions for a full
explanation of this.

... but donÕt be careless. There are a few simple rules which should be followed in order to avoid
possible damage due to improper installation. For example, in the worst
case, you may destroy your computer if it is running when you install
the card. Therefore please follow the instructions in this manual or your
computer userÕs guide carefully. You will be rewarded with increased
productivity.

The following instruction describes the installation of your new
MacMagicª on a typical tower or desktop Apple Macintosh model. If
your systemÕs configuration is different please look in its documentation
in the chapter ÓExpanding your ComputerÓ.

IIIInnnnssssttttaaaallllllllaaaattttiiiioooonnnn    iiiinnnn    yyyyoooouuuurrrr    ccccoooommmmppppuuuutttteeeerrrr    ............    ttttiiiimmmmeeee    ttttoooo
ggggeeeetttt    sssseeeerrrriiiioooouuuussss::::

1. Turn off your computer. Leave the power cord plugged in, however, to
act as a ground during the installation process. 

2. Remove the monitor signal cable from your computer. If you have one or
more graphic cards already installed please remove their cables as well.
You may have to first remove a couple of screws on the cable plugs in or-
der to do this.
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OOOOppppeeeennnniiiinnnngggg    aaaannnn    AAAApppppppplllleeee    ddddeeeesssskkkkttttoooopppp    mmmmooooddddeeeellll::::
3. Press both buttons which are located on the front of the computer on the

outer edge under the ledge, and pull the case forward and then up. You
have just removed the outer case of your computer. On the upper left
side you will find a plastic cover which can be folded out. Your Macin-
toshÕs three PCI extension slots are located under this.

OOOOppppeeeennnniiiinnnngggg    aaaannnn    AAAApppppppplllleeee    ttttoooowwwweeeerrrr    mmmmooooddddeeeellll::::
3. Press the green button on the top of the tower to unfasten the left part of

the case and remove it. With the Macintosh opened in this manner the
PCI extension slots are located in the lower part.

4. Now touch the metal surface of the power supply unit (the recessed
metal parts inside the Macintosh). Do not be surprised if you get a little
shock (also known as an ESD or Electro Static Discharge). This shock is
completely harmless for your finger but could destroy your graphic card
or computer.

Touching the grounded power supply unit (The power cord should still be
attached to the computer and plugged into an outlet) prevents any elec-
tro-static charge from destroying the graphic card.

5. On the back of your computer you will find metal plates covering three
slots. In order to make space for the monitor connectors of your graphic
card take the metal cover plate off of one of these slots and remove it
from the computer. You will need a screwdriver in order to do this.

What should you do with the metal plate you have just removed? A good
place to save it is the bottom of the case where you will be able to locate
it easily in case you need it again. Tape it there carefully so that it will
not become loose and cause possible damage by moving around.

6. Hold the MacMagicª in both hands as shown in the picture. Be careful
not to tilt the card as this could cause a short-circuit. Now stick the card
in the extension slot. Do not use force. Gently press the card until it fits
snugly. If you need to, wiggle it back and forth slightly to make sure that

11/29/98 © Village Tronic 7



itÕs connected firmly.  After the card is connected use the screw to fix it
in place. If you have installed it properly the screw which you removed
earlier from the metal plate should fit.

7.  Close the computer cover. This completes the difficult part of the instal-
lation.

8. Now you only have to connect the cardÕs cables. MacMagicª is a 3D
game card which can not depict 2D objects. This includes, for example,
your Macintosh desktop. This is why MacMagicª is usually attached to
your existing 2D card and your monitor.

A small connecting cable should have been delivered with your
MacMagicª. On one end it has a VGA interface (Please refer to picture
ÓMacintosh portÓ) and on the other a Macintosh interface (Please refer to
picture ÓVGA portÓ). Please use this cable to connect your old graphic
card to your new MacMagicª according to the following instructions.

AAAA    MMMMaaaacccciiiinnnnttttoooosssshhhh    MMMMoooonnnniiiittttoooorrrr    aaaannnndddd    MMMMaaaaccccMMMMaaaaggggiiiiccccªªªª    
If you have a Macintosh compatible monitor then please stick the moni-
tor cable in the Macintosh port of your MacMagicª The free VGA port of
the MacMagicª should now be connected to the onboard video or other
graphic card. Please use the cable supplied for this.

The installation should look like the following picture. Now you can
breath deeply. The difficult part is finished and you may turn to the
chapter on software installation.

AAAA    PPPPCCCC    MMMMoooonnnniiiittttoooorrrr    aaaannnndddd    MMMMaaaaccccMMMMaaaaggggiiiiccccªªªª    
If you happen to own a PC compatible monitor, i.e. a monitor that can
only be used with a Macintosh in connection with an adapter, please plug
the monitor cable into the VGA-Output port of your MacMagicª. Leave
your monitorÕs adapter attached to your 2D graphic card and plug the
supplied cable into the Macintosh port of your MacMagicª. Please plug
the remaining cable end into the monitor adapter.

The installation should look like the following picture. Now you can
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breath deeply. The difficult part is finished and you may turn to the
chapter on software installation.

HHHHoooowwww    eeeexxxxaaaaccccttttllllyyyy    ddddooooeeeessss    tttthhhhiiiissss    cccchhhhaaaaiiiinnnn    ccccoooonnnnnnnneeeeccccttttiiiioooonnnn    wwwwoooorrrrkkkk????
As mentioned at the beginning, MacMagicª is a 3D game card which
has been developed and produced in order to speed up 3D games and
greatly improve the quality of their graphics.

That means that the pictures you see on your monitor are created, as be-
fore, by your onboard graphic card and then sent to the MacMagicª.
Upon arrival MacMagicª checks if they are from a compatible 3D game
which it can speed up. This test is always negative when it is dealing
with something like your Macintosh desktop or any other application
which wants to depict something like menus, windows, etc. on your
monitor (e.g. Macintosh Finder). In this case MacMagicª lets the signals
continue on to the monitor unchanged.

However, if MacMagicª determines that the image it has received deals
with a compatible 3D full screen game (e.g. Unreal, Tomb Raider 2 or
Myth), it turns off the incoming signal from your 2D card and turns its
own on. You can easily tell when this happens because your desktop pic-
ture disappears briefly and the screen makes a slight sound. You may al-
ready know this sound from when you change the resolution.
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SSSSooooffffttttwwwwaaaarrrreeee    IIIInnnnssssttttaaaallllllllaaaattttiiiioooonnnn

Now that the graphic card is located in your computer and has been cor-
rectly connected, it is time to install the needed software. Only with this
software, the so-called driver, can MacMagicª do its work.

1. Turn on your computer.

2. 1 If you have received an installation disk with the name MacMagicª,
please use this for the installation. Insert the disk into the floppy disk
drive and start the installation program.

2.2 If no disk was delivered with your card, then the driver is located on the
VillagePost CD. When you insert the CD in your CD-ROM drive a window
will open automatically. Click on ÓSoftware InstallationÓ.

3. Confirm the installation steps by clicking the OK button.

4. Then click on the Install button and determine where you would like the
driver to be installed.

WWWWhhhhaaaatttt    eeeexxxxaaaaccccttttllllyyyy    hhhhaaaavvvveeee    yyyyoooouuuu    iiiinnnnssssttttaaaalllllllleeeedddd????
After a successful installation the following will be found in the system
folder:

3333DDDDffffxxxxGGGGlllliiiiddddeeeeLLLLiiiibbbb2222....xxxx

This is the Glide driver for MacMagicª. It is necessary in order for Glide
commands from games such as Quake to find their way to MacMagicª.
If this driver is not installed in your system folder no Glide compatible
game will profit from your new MacMagicª.

MMMMaaaaccccMMMMaaaaggggiiiicccc    RRRRAAAAVVVVEEEE

This is the RAVE driver for MacMagicª It is needed to speed up games
which are based on AppleÕs Quickdraw3D technology. Without it your
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new MacMagicª is not present for Quickdraw3D games, although it was
installed.

After installation the following will be found in your MMMMaaaaccccMMMMaaaaggggiiiiccccªªªª folder:

MMMMaaaaccccMMMMaaaaggggiiiicccc    TTTTwwwweeeeaaaakkkkeeeerrrr    1111....0000EEEE

MacMagicTweakerª is a program with which you can ÓtweakÓ or tune
the settings of MacMagicª. The presence and use of this program is op-
tional and not necessary for the card to function properly.

IIIInnnnssssttttaaaallllllllaaaattttiiiioooonnnn    LLLLoooogggg

This provides information about the exact locations of the installed data.
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CCCCaaaarrrrdddd    ttttuuuunnnniiiinnnngggg    sssslllliiiigggghhhhttttllllyyyy    ddddiiiiffffffffeeeerrrr----
eeeennnnttttllllyyyy::::

MMMMaaaaccccMMMMaaaaggggiiiiccccTTTTwwwweeeeaaaakkkkeeeerrrrªªªª    ----    wwwwhhhhaaaatttt    iiiissss    iiiitttt    rrrreeeeaaaallllllllyyyy????
MacMagicTweakerª is an application with which you can change di-
verse settings of your new MacMagicª 3D accelerator card. In some
cases these changes dramatically improve the performance of the card.
Embedded in a voodoo doll interface MacMagicTweakerª allows you to
tune MacMagicª individually for every game.

IIIImmmmppppoooorrrrttttaaaannnntttt    ddddiiiissssccccllllaaaaiiiimmmmeeeerrrr:::: Not all tuning functions can be used with every card! The MacMagicª
functions guaranteed by us only work with the standard setting of 50
MHz. Choosing a higher setting will not destroy the card, but may cause
the image to freeze. We would like to clearly point out that no claim can
be made for a card that can work in every possible tuning configuration.
The wide range of possible clock speeds was only chosen to let the user
tweak every card to its peak performance level.

WWWWhhhhaaaatttt    ccccaaaannnn    bbbbeeee    ÓÓÓÓttttwwwweeeeaaaakkkkeeeeddddÓÓÓÓ????
You start the program MacMagicTweakerª by double-clicking on it. A
voodoo doll appears on the screen. Four needles are stuck in the doll. By
clicking and dragging a needle you can change the value of the field next
to it.

TTTThhhheeee    GGGGrrrraaaapppphhhhCCCClllloooocccckkkk    sssseeeettttttttiiiinnnngggg:::: With this needle you can change the clock speed of the card. The stan-
dard setting is 50 MHz. By moving the needle it can be increased to 60
MHz.

The general rule is the faster the clock speed of the card, the higher the
frame rate in a game can be. On the inside of the packaging you will find
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our measurements with Quake, which should give you a clue for different
settings.

TTTThhhheeee    VVVVssssyyyynnnncccc    sssseeeettttttttiiiinnnnggggssss:::: This option can clearly influence the performance of your MacMagicª
(see inside of packaging). Vsync is the signal that the card sends out to
the monitor when it has depicted a picture completely on the screen. Nor-
mally computer games are programmed in such a way that they wait for
this signal before they show the next calculated image. The
MacMagicTweakerª allows you to decide yourself if and how long
should be waited. Following are explanations for the different Swap
Buffer settings.

vvvvssssyyyynnnncccc====ddddeeeeffffaaaauuuulllltttt The default setting adopts the settings which were chosen by the devel-
oper of each game. Normally this is waiting for the vsyncs before the
next picture is made available.

vvvvssssyyyynnnncccc====0000 In the 0 setting MacMagicª prepares the pictures as quickly as possible,
without explicitly waiting for a vsync. This setting avoids waiting cycles
and establishes the fastest calculable performance. The only disadvan-
tage of this method is that slight displacement may occur if a horizontal
line appears in two consecutive pictures. This effect, however, if it does
occur, is only optical.

vvvvssssyyyynnnncccc====1111 When set to wait 1 vsync, MacMagicª is programmed for what most
games use as their standard setting. That means that this setting should
usually be the same as default.

vvvvssssyyyynnnncccc====2222 When set to wait a full 2 vsyncs, MacMagicª has its slowest perform-
ance because a new picture will only be shown after two vsyncs. A dis-
placement, such as may occur with 0, is practically impossible in this
setting.

TTTThhhheeee    RRRRAAAAMMMM    sssseeeettttttttiiiinnnnggggssss

There are 8 MB of RAM on your MacMagicª card. 4 MB are used for
the frame buffer. The other 4 MB are for textures (texture buffer). The
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more texture memory the card has and the more the game actually uses,
the faster the card can work. If the texture memory is too small, the ob-
jects have to be transmitted over and over again from the computerÕs
RAM to the graphic card. The general rule is: The more texture memory
there is, the faster MacMagicª can compute the pictures.

TTTTeeeexxxxttttuuuurrrreeee    MMMMeeeemmmmoooorrrryyyy Unfortunately some games donÕt know what to do with 4 MB of texture
memory. Even worse, in some cases they crash when there is too much
memory available. With this setting you can limit the texture memory to
2 MB, which will allow you to also play such games with your
MacMagicª.

TTTThhhheeee    RRRReeeeffffrrrreeeesssshhhh    sssseeeettttttttiiiinnnngggg Like every graphic card your MacMagicª also operates with a refresh
rate. This is the number of pictures per second that MacMagicª sends to
the screen (measured in Hz). The general rule is: The higher this is set,
the less the monitor tends to flicker. 

The refresh rate has nothing to do with the frame rate as a measure of perform-
ance for games. An example: Even when a game like Quake only reaches
a frame rate of 25 fps per second, the card can still be set to 85 Hz or
more.

As a comparison: You have the same effect with a 100 Hz television
screen. 25 pictures per second are sent, but they are depicted at 100 Hz.
Therefore, in order to eliminate the characteristic flickering, every pic-
ture is shown on the screen four times before the next picture is deliv-
ered.

To experience the full performance potential of your MacMagicª, play a
little bit with the MacMagicTweakerª. The attainable results are notice-
able, as our measurements (see inside of packaging) show.

HHHHoooowwww    ddddoooo    yyyyoooouuuu    ÓÓÓÓttttwwwweeeeaaaakkkkÓÓÓÓ????
The key for tuning is the so-called ÓTweak fileÓ. This file contains the
settings with which you can manage your MacMagicª. Every time you
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start a game your card looks for such a file in the game folder. If there is
one the settings are taken over as they are.

YYYYoooouuuu    wwwwoooouuuulllldddd    lllliiiikkkkeeee    ttttoooo    sssseeeetttt    uuuupppp    aaaa    nnnneeeewwww    TTTTwwwweeeeaaaakkkk    ffffiiiilllleeee    ffffoooorrrr    aaaa
ggggaaaammmmeeee::::

1. Start the MacMagicTweakerª and use the needles to choose the desired
settings.

2. Choose Save Tweak file... from the File menu.

3. Save the file in the folder of the game you would like to tweak.

4. Quit MacMagicTweakerª and start the game as usual.

YYYYoooouuuu    wwwwoooouuuulllldddd    lllliiiikkkkeeee    ttttoooo    cccchhhhaaaannnnggggeeee    aaaannnn    eeeexxxxiiiissssttttiiiinnnngggg    TTTTwwwweeeeaaaakkkk    ffffiiiilllleeee::::
1. Open the folder of the game that you would like to change the

MacMagicª settings for.

2. Double click the Tweak file.

3. The MacMagicTweakerª will open with the saved settings for the cho-
sen game.

4. Make your changes to the saved settings.

5. Choose Save Tweak file... from the File menu and save the file in the ap-
propriate game folder.

6. Click on the save button in the window and confirm that you would like
to replace the existing file with the new one by clicking OK. This is how
the new settings are activated.

It is also possible to open a Tweak file by double clicking on Open Tweak
file... from the File menu.
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UUUUnnnnlllliiiimmmmiiiitttteeeedddd    ffffuuuunnnn    oooonnnn    tttthhhheeee    tttteeeelllleeeevvvviiii----
ssssiiiioooonnnn    ssssccccrrrreeeeeeeennnn    wwwwiiiitttthhhh    MMMMaaaaccccPPPPaaaabbbblllloooo

Perhaps you noticed a small round plug on the back of the card when you
were installing your MacMagicª. This is a S-VHS output port and proof
that even our least expensive 3D accelerator is expandable.

Our MacPablo can be added to your MacMagicª. The smallest module of
our series, MacPablo, can be simply plugged into the MacMagicª. It fits
in every computer in which the MacMagicª fits alone. No additional slot
is needed.

If this additional module is built in, the S-VHS output port on the back of
the card can be used. Innumerable possibilities are created by using
MacPablo:

¥ A big television can be attached so you will never again have to miss the
fun of playing on a Óbig screenÓ. Your opponents will appear much bigger
and more sinister. The size difference in comparison to a computer
screen is enormous.

¥ The sound system of a TV is also often better than the MacintoshÕs
speakers. The better the sound, the more atmosphere the game has.

¥ Games can be shown on a television and computer screen at the same
time. This is excellent for demonstrations or presentations of games.

¥ Thanks to MacPablo game sequences can be recorded by simply attach-
ing a video recorder. Why not show your friends how to get rid of the
last opponents in Unreal?
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HHHHoooowwww    ddddoooo    yyyyoooouuuu    ccccoooonnnnffffiiiigggguuuurrrreeee    MMMMaaaaccccPPPPaaaabbbblllloooo????
As with all MacMagicTweakerª settings, the options for MacPablo can
be set and saved individually for each game. If MacPablo is installed, the
command Option... in the Window menu can be activated. The following
window appears when this command is chosen:

TTTThhhheeee    iiiinnnnddddiiiivvvviiiidddduuuuaaaallll    sssseeeettttttttiiiinnnnggggssss::::
Use MacPablo This box allows you to turn MacPablo on and off with the click of the

mouse.

Position The position of the computer image on the television screen can be
changed by clicking the arrows.

Signal type Here you choose if the attached equipment has a S-VHS or FBAS connec-
tion. MacPablo then provides the appropriate signal.

TV Standard With a click of the mouse you can set the applicable TV standard (e.g.
NTSC in USA or PAL in Germany) for your television or video recorder.

Filtering Computer images usually flicker on a television screen. You can elimi-
nate this flickering with these options for filtering out this tendency. The
more lines you use for the filtering process the more stable the picture
becomes. However, the clarity of the picture is also reduced.

Test Picture Click this box if you would like a picture to test your video installation
with. There are three different test pictures to choose from. Use them to
check MacPabloÕs functions and adjust the picture on the television
screen before you begin the game.

Test on This turns on a test picture which is sent from MacMagicª to the televi-
sion via MacPablo. It is a colorful triangle which is upside down. This
test picture makes positioning the MacPablo picture on the television
easier. The picture can be turned on and off (MacPablo remains active)
by using the ESC key. It is possible to switch between the test picture
and the dialog box by pressing the ESC key.
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GGGGlllloooossssssssaaaarrrryyyy

DDDDeeeepppptttthhhh:::: The number of colors simultaneously available. The number depends on
the graphic card used and the selected screen resolution.

MMMMiiiilllllllliiiioooonnnnssss    ooooffff    ccccoooolllloooorrrrssss:::: 16 millions (= 16,777,216) colors can be depicted simultaneously. This
mode is also called 24-Bit mode, 32-Bit mode, or True Color.

TTTThhhhoooouuuussssaaaannnnddddssss    ooooffff    ccccoooolllloooorrrrssss:::: 32 thousand (= 32,764) colors can be depicted simultaneously. This
mode is also called 16-Bit mode or High Color.

222255556666    ccccoooolllloooorrrrssss:::: A selection of 256 colors from 16 million can be used. This mode is also
called 8-Bit mode.

222255556666    sssshhhhaaaaddddeeeessss    ooooffff    ggggrrrraaaayyyy:::: A selection of 256 shades of gray can be used.

11116666    ccccoooolllloooorrrrssss:::: A selection of 16 colors from 16 million can be used. This mode is also
called 4-Bit mode.

11116666    sssshhhhaaaaddddeeeessss    ooooffff    ggggrrrraaaayyyy:::: A selection of 16 shades of gray from 256 can be used.

4444    ccccoooolllloooorrrrssss:::: A selection of 4 colors from 16 million can be used. This mode is also
called 2-Bit mode.

4444    sssshhhhaaaaddddeeeessss    ooooffff    ggggrrrraaaayyyy:::: A selection of 4 shades of gray from 256 can be used.

BBBB////WWWW:::: Just black and white can be used. This mode is also called 1-Bit mode.

RRRReeeeffffrrrreeeesssshhhh    rrrraaaatttteeee:::: This is the number of pictures shown per second (1 picture per second =
1 Hz). For ergonomic reasons the refresh rate should not be less than 75
Hz.

RRRReeeessssoooolllluuuuttttiiiioooonnnn:::: This is the number of pixels on the screen, e.g. horizontal 832 pixels,
vertical 624 pixels.

OOOOnnnnbbbbooooaaaarrrrdddd    ggggrrrraaaapppphhhhiiiicccc    ccccaaaarrrrdddd:::: This is the standard graphic card which is installed in your Macintosh.
Usually it is located on the motherboard.

VVVVGGGGAAAA    iiiinnnntttteeeerrrrffffaaaacccceeee    pppplllluuuugggg:::: This is the plug that is used throughout the WinTel world to connect a

MacMagic, V1.018



monitor to a computer (ItÕs a 15 pin HD-SUB-D plug).

MMMMaaaacccciiiinnnnttttoooosssshhhh    iiiinnnntttteeeerrrrffffaaaacccceeee    pppplllluuuugggg:::: This is the type of plug that is used to connect a Macintosh compatible
monitor to a Macintosh (ItÕs a 15 pin SUB-D plug).

VVVVGGGGAAAA    AAAAddddaaaapppptttteeeerrrr:::: This is a small plug which is needed in order to attach a PC compatible
monitor to a Macintosh computer. It is usually delivered with the moni-
tor, but may have to be obtained extra.

DDDDrrrriiiivvvveeeerrrr:::: This is a computer program, usually a system extension, which contains
the necessary commands to control and use hardware. 

GGGGlllliiiiddddeeee:::: This is a 3D API from 3Dfx Interactive, Inc.

AAAAPPPPIIII:::: Application Programming Interface is a software layer which applica-
tions and application programmers rely on. The use of standardized APIs
allows programs to interact easily with different drivers.

RRRRAAAAVVVVEEEE:::: This is part of AppleÕs Quickdraw3D API and connects the 3D API to a
3D hardware accelerator. The RAVE driver from Village Tronic, for ex-
ample, enables your new MacMagicª to carry out Quickdraw3D com-
mands instead of your main computer processor.

FFFFrrrraaaammmmeeee    RRRRaaaatttteeee    ((((ffffppppssss)))):::: This is the number of newly computed pictures that a 3D game can de-
pict on a monitor. The higher the frame rate, the lower the tendency for
the game to appear jerky on the screen. 15 fps is usually considered a
good level for games. At 25 fps or more movement on the screen ap-
pears smooth to the human eye.

VVVVssssyyyynnnncccc:::: This is a signal that the graphic card sends to the monitor to tell that the
picture is completed.

SSSSwwwwaaaapppp    BBBBuuuuffffffffeeeerrrr:::: This is where your MacMagicª prepares the next picture while the one
in the Frame Buffer is being sent to the screen.

FFFFrrrraaaammmmeeee    BBBBuuuuffffffffeeeerrrr:::: This is the part of the graphic cardÕs memory in which the picture for the
monitor is stored. It is kept there until it is replaced with the one from
the Swap Buffer.

ssssllllooootttt    ccccoooovvvveeeerrrr    ppppllllaaaatttteeee:::: This is the piece of metal that covers unused expansion slots.
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TTTTeeeecccchhhhnnnniiiiccccaaaallll    ddddaaaattttaaaa::::    VVVVooooooooddddoooooooo    GGGGrrrraaaapppphhhh----
iiiiccccssss    ffffeeeeaaaattttuuuurrrreeeessss::::

¥ Perspective correct texture mapping

¥ Bi-linear and advanced texture filtering

¥ Level of detail (LOD) MIP mapping

¥ Sub-pixel correction

¥ Polygonal-based Gouraud shading and texture modulation

¥ 24-bit internal, 16-bit dithered RGB frame buffer

¥ Multiple format texture buffer (8-bit and 16-bit)

¥ 4 Mbytes of frame/aux buffer memory per pixelfx

¥ 4 Mbytes of texture memory per texelfx

¥ 45 Mpixels/sec sustained fill rate for bi-linear or advanced filtered tex-
tures

¥ Over 1M triangles/sec for filtered, LOD MIP-mapped, Z-buffered, alpha-
blended, fogged, textured 25-pixel triangles
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LLLLeeeeggggaaaallll    PPPPooooiiiinnnnttttssss::::

This manual and software are protected by copyright. All rights are reserved. No part of this docu-
ment or software may be reproduced (using any kind of system, including but not limited to optical,
electronic, magnetic, chemical, mechanical, and acoustical systems), transmitted, transcribed, stored,
processed, given to another party, or translated into any language, including computer languages,
without the prior written consent of Village Tronic Marketing GmbH.

This product was created with great care. Unfortunately we can not guarantee that no problems will
arise. Neither Village Tronic Marketing GmbH nor the authors can be held liable or in any way re-
sponsible for possible errors or incidental consequential damages in connection with this material or
the software. Suggestions for improvement are always welcome.

Copyright © 1998 Village Tronic Marketing GmbH.
All rights reserved.
Village Tronic Marketing GmbH
M�hlenstr. 2
31157 Sarstedt
Germany

The name Apple, the Apple logo, Power Macintosh and Macintosh are trademarks of Apple Computer,
Inc., registered in the USA and other countries. Nubus is a trademark of Texas Instruments. Village
Tronic and MacMagicª are registered trademarks of Village Tronic Marketing GmbH.

Other company and product names mentioned in the handbook are trademarks of their respective
companies. Exclusion of the trademark symbol does not indicate that a label is a free trade name.
Mention of products which are not from Village Tronic is for informational purposes only and is not a
misuse of a trademark. Village Tronic Marketing GmbH shall not be held liable for the choice, per-
formance or use of this product. 
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HHHHeeeellllpppp    aaaannnndddd    ccccoooonnnnttttaaaacccctttt    aaaaddddddddrrrreeeesssssssseeeessss

If you have problems or questions about MacMagicª, please try to find a solution with the help of
this manual. If you canÕt find an answer in the material provided, please contact your dealer. If you
purchased MacMagicª directly from Village Tronic, or your dealer could not help you, our support
team is there for you. 

Up-to-date information and drivers can be found at hhhhttttttttpppp::::////////wwwwwwwwwwww....vvvviiiillllllllaaaaggggeeeettttrrrroooonnnniiiicccc....ccccoooommmm.
Direct contact with our support team is via E-mail:  ssssuuuuppppppppoooorrrrtttt@@@@vvvviiiillllllllaaaaggggeeee....ddddeeee
Naturally we are also available via Fax, letter or telephone. The address and fax and telephone num-
bers are at the end of the chapter. Please understand that our support team is not available at all
times and places.

In the Internet you will find us at hhhhttttttttpppp::::////////wwwwwwwwwwww....vvvviiiillllllllaaaaggggeeeettttrrrroooonnnniiiicccc....ccccoooommmm. There we provide new versions of
the programs and driver for your MacMagicª, as well as additional information.

Village Tronic Marketing GmbH
M�hlenstr. 2
D-31157 Sarstedt
Telefon: +49 5066 7013 0
Telefax: +49 5066 7013 49
E-mail: orders@villagetronic.com

support@village.de
marketing@villagetronic.com

Special thanks to:
Chris, Kathy, Peter and Tony at Apple Computer, Inc., Nick Pandher at 3Dfx interactive, Inc., Lynnea
and Felix. All other contributors are hereby respectfully acknowledged.

Dear Marc Niklaus, thank you so much for spending all those endless nighshifts trying to communi-
cate with one supplier.
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